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Level TROLL® 400, 500, 700, and 700H

In order to deploy the instrument, complete the following
steps.

¢ Connect the instrument to a computer or
RuggedReader.

¢ Connect the instrument to the software and setup a
site and a data log.

« Install the instrument in the water. (If you are using a
level reference set it at this time.)

« Verify the installation position then disconnect the
instrument from the computer or RuggedReader.

e Secure the cable and install the desiccant.

Select a TROLL Com Communication
Device

The subsequent figure shows the function and connection
features of the TROLL Com Communication Device
models.

¢ A Direct-Connect TROLL Com might be preferred
for programming an instrument that will be deployed
on a suspension cable.

o A RuggedCable System and a Cable-Connect
TROLL Com are required if you intend to
communicate with the instrument while it is
deployed. However, you can program the instrument
with any TROLL Com.
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o Aserial (RS232) TROLL Com is required for use
with a RuggedReader Handheld PC.

RS232
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Serial port on a PC/laptop and RuggedReader
Handheld PC
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Cable-Connect TROLL Com Communication
Device, serial connection, for field use

Direct-Connect TROLL Com Communication
Device, serial connection, programming only, not
submersible

USB port on a PC/laptop

Direct-Connect TROLL Com Communication
Device, USB connection, programming only, not
submersible

Cable-Connect TROLL Com Communication
Device, USB connection, for field use
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Connecting the RuggedCabIe System
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Connect the Instrument to the RuggedCable
System

Remove the protective caps from the instrument and
cable. Ensure that the O-ring on the instrument
connection is clean.

Locate the flat side of each connector and notice the pins
on the instrument connector and the slots on the cable
connector.
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Slide back the sleeve on the cable connector.
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Position the instrument and cable flat edges so they will
connect properly. Insert the instrument connector firmly
into the cable connector.
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Slide the cable sleeve toward the instrument until the pin
on the instrument fits into the hole in the slot on the cable
connector.

Hold the textured section of the sleeve in one hand and
the instrument in the other. Push and twist until you hear
aclick. The click ensures the cable and instrument are
securely attached.

fnnovations in
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Connect TROLL Com Communication Device to
the RuggedCable System

. Ifadesiccantis present, remove the desiccant from the

cable. Hold the textured section of the cable connector in
one hand and the desiccant in the other. Twist in
opposite directions to unlock the desiccant from the
cable.
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. Position the TROLL Com and the cable flat edges so

they will connect properly. Insert the TROLL Com
connector firmly into the cable connector.
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. Hold the textured section of the sleeve in one hand and

the TROLL Com in the other. Push and twist until you
hear a click. The click ensures the cable and TROLL
Com are securely attached.

Field Deployment

Program the Instrument

In order to set up a log or download data, you must
connect the instrument to a computer running Win-Situ 5
Software, or a RuggedReader Handheld PC running Win-
Situ Mobile. Refer to the Win-Situ 5 or Win-Situ Mobile
section. See page 2.

Position the Instrument

Place the instrument at the desired depth. Position the
instrument below the lowest anticipated water level, but
not so low that the pressure sensor range might be
exceeded at the highest anticipated water level. Refer to
the tables below to determine usable depth.
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A BaroTROLL Instrument can be deployed
with a non-vented instrument to compensate
level data for changes in atmospheric
pressure. Make sure the clocks on both
instruments are synchronized, and install the
BaroTROLL in alocation that will never be

submerged in water.

Non-Vented Level TROLL Instrument

Range Effective Range Usable Depth
PSIA | PSIA kPA Meters Feet
30 155 106.9 11 35
100 85.5 589.5 60 197
300 285.5 1968 200 658
500 4855 3347 341 1120
1000 | 985.5 6795 693 2273

* Effective range for psia sensors is limited by an estimated 14.5
PSI atmospheric pressure at sea level.

Vented Level TROLL Instrument

Range Usable Depth
PSIG kPA Meters Feet
5 345 35 115
15 103.4 11 35
30 206.8 21 69
100 689.5 70 231
300 2068 210 692
500 3447 351 1153

Verify Instrument Depth

After you have installed the instrument, it is possible to
connect the instrument to a computer or RuggedReader,
open the software, and take a reading to verify the
installation position. If the reading confirms that the
instrument is in the correct position, you can secure it as
described below.

During log setup there was an option to "Remind Me Later

for setting a level reference. If you set the log to remind you
later, ensure that the instrument is submerged and set the
level reference when prompted.

Secure the Cable
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1 Well Dock Installation Ring

2 Kellems Grip

3 Instrument Installed in Well

Desiccant

Desiccant protects electronics from condensation, which
can cause irreparable damage and loss of data. Indicating
desiccant changes from blue to pink as it becomes
saturated with moisture.
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Desiccant stages (from left)
New, nearly expired (replace now), expired

Itis extremely important to use a properly-sized
desiccant for your deployment and to change desiccant
often. Desiccant should be changed before the entire
volume has turned pink, and you should use enough

desiccant to effectively keep cables, instruments, and
electrical boards dry until your next scheduled
maintenance. Desiccant life span is dependent on site
conditions.

Installing Desiccant with Twist-Lock
Connectors

. Remove the protective dust cap from the bottom of the

desiccant pack, if applicable.

. Remove expiring desiccant (if present) from the cable by

grasping the textured section of the cable connector in
one hand and the desiccant in the other. Twist in
opposite directions to unlock the desiccant from the
cable.

. Attach the new desiccant pack to the twist-lock
connector on the cable.
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Installing Outboard Desiccant

Vented cable must be installed with outboard desiccant to
protect the cable and instrument electronics from
condensation in high-humidity environments.

The desiccant can be removed from the vent tube, if
necessary, to trim the conductor wires. However, you must
reinstall the desiccant after trimming and connecting the
wires.

. Cut off the knot at the bottom of the vent tube extension.

. Firmly attach the vent tube extension to the cable vent
tube. Cover at least 6.4 mm (0.25in.) of the cable vent
tube for a secure attachment.

Information subject to change without notice. In-Situ, In-Situ logo, Baro Merge, BaroTROLL, HERMIT, iSitu, Pocket-Situ, RDO, RuggedCable, RuggedReader, TROLL, and Win-Situ are trademarks or registered trademarks of In-Situ Inc. ©2013. Al rights reserved.

. Use the attached hook-and-loop strap to secure the

desiccant to the cable, below the stripped wires.

. Remove the red dust cap from the black nylon cap to

allow air to reach the cable’s vent tube.

Outboard desiccant is attached to the cable

vent tube.
2 ‘ Desiccant is secured to the cable with a strap.
Safety

The instrument complies with all applicable directives
required by CE and the FCC and is found to comply with
EN 61326, ICES-003, and FCC Part 15 specifications.
Declarations of conformity may be found in the Operator's
Manual.

Win-Situ 5 Software

Use Win-Situ 5 with a laptop or a PC and the Aqua
TROLL, Level TROLL and Rugged TROLL Instruments.
To learn more about Win-Situ 5, refer to the Help menu.
Training videos are available on the In-Situ Inc. website
www.in-situ.com under Tech Resources.

Install Win-Situ 5

Insert the software CD that came with your product or
download Win-Situ 5 from the In-Situ website at www.in-
situ.com/software. Follow the on-screen prompts of the
Installation Wizard to complete installation.

IMPORTANT: Install COM drivers when prompted.

Connecting an Instrument to the Software

When you open Win-Situ 5 Software, you are asked if you
want to connect to your device. Click Yes. Synchronize the
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instrument clock to the PC clock. E

Parameters and measurements are displayed in light gray
on the home screen if a connection is established. Click
the Play button .= to view live readings.

The software displays an error message if a connection
cannot be established.

Selecting the Correct COM Port

If you are usinga USB TROLL Com, select the correct
COM port by following the steps below. If you are using a
serial TROLL Com, the Win-Situ Software should default
to the correct COM port, which is usually COM 1.

Steps for Windows 8 systems.

Right-click the Start screen.
Select All Apps.

Click Control Panel.

Open the Device Manager.

Click the arrow next to Ports (Com and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

Steps for Windows 7 systems.

. Minimize the Win-Situ Software.

Click the Windows Start button, and open the Control
Panel.

Click Hardware and Sound, and open the Device
Manager.

. Click the arrow next to Ports (COM and LPT), and

locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

Steps for Windows XP systems.

. Minimize the Win-Situ Software.

Click the Windows Start button, and open the Control
Panel.

Double-click the System icon. Click the Hardware tab,
and open the Device Manager.

1.

Click the plus sign next to Ports (COM and LPT), and
locate the USB Serial Port listing. The number listed
next to this entry is your COM port address.

The following steps apply for all Windows
operating systems.

. Once you have determined the correct COM port

address in your operating system, reopen Win-Situ 5
Software.

2. Close any open windows in Win-Situ Software.

Click Preferences.

4. Click Comm Settings, and then click the Port Number

menu.

Scroll down to find the correct COM port address. Click
the check mark to accept the changes.

Click the yellow Connect button in the lower right corner
to establish a connection to the instrument.

Set Up a Data Site
Click the Site button.

[ Win-situ® 5
File Edit View Preferences F

Select either Default Site or click the New button to set
up a custom site.

Enter a Site Name. Entering coordinates and uploading
a picture are optional.

Click the check mark to save the data site.
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Setup a Data Log

. Click the Logging tab.

& Win-Situ® 5

File Edit View Preferences Help
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3. Select your site, and name the new log.

o

Select the parameters you intend to monitor. You can
rearrange their order and select different units.

Select alogging method appropriate for your
deployment.

Configure the logging method.

Select a start condition.

When an instrument is deployed on a wire,
rather than a cable, you will not be able to
communicate with it after installation. Select a
Scheduled start if you are deploying an
instrument on a wire.

Select alevel reference type.

9. Configure the level reference. Select “Set First Logged

Reading To” if you are using a scheduled start, or
“Remind Me to Set Reference Later” if you are using a
manual start and are NOT deploying the instrumenton a
wire.

fnnovations in
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" Quick Start Guide

IMPORTANT: Your instrument MUST be
installed in its final location to set the level
reference correctly. If you are setting up a data
log before installing your instrument in its final
location, you will need to select either “Set First
Logged Reading To” or “Remind Me to Set
Reference Later.”

Enter a specific gravity value for the deployment.

The software displays a summary. Review your
selections carefully before clicking the check mark.

Start the log. A Scheduled Start log will start
automatically at its programmed time. To start a Manual
log, go to the Logging tab, highlight the log name, and
tap the Start button.

Real-Time Data Readings

To view real-time data readings, click the Start button on
the Home screen. The parameter readings will turn black
and update periodically. Click the Start button again to
stop reading in real time.

IMPORTANT: You cannot create a new log if you
have real-time readings enabled.

Downloading Data to a PC

This procedure copies the data log from the instrument to
a PC. It does not remove the data log from the instrument.
After alog is downloaded, it can be exported to a CSV file
format that can be used by spreadsheet programs. The
time shown in the log name is the time the log was
downloaded.

. With an instrument connected, select the Logging tab

[

Select the log you intend to download.

Choose a Running, Suspended, Stopped, or Deleted
log.

Click the Download | ¥’ button.

5. Inthe next screen, select one of the three download

options.
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o Alldata
+ New data (data logged since the last download)

e Time interval to download

New data is downloaded by default to a new
log file. To append new data to the last

Vf download of this log, be sure the option
"Append logs on download" is selected in the
General Settings dialog (Preferences >
General Settings).

2. Thelogis copied to the connected PC into your Win-Situ
working directory folder. View or change the working
directory using File > Settings.

. Atthe end of the download, Win-Situ gives you the
option of viewing the data.

o Select Yes and the log is displayed in the Data
screen.

« Select No and the Logging screen appears. You
can view the data at any time by selecting itin the
Data tab.

Win-Situ Mobile Software

Use Win-Situ Mobile with a RuggedReader Handheld PC
and Aqua TROLL, Level TROLL, and Rugged TROLL
Instruments. Training videos are available on the In-Situ
Inc. website www.in-situ.com under Tech Resources.

Connect an Instrument to the Rugged Reader
Serial Port
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: 1. Rugged Reader

| 2. Communication Cable
—© 3. RuggedCable System
4. In-Situ instrument
-0

Connect to the Software

With an instrument connected, tap the Start button on the
RuggedReader. Tap Win-Situ Mobile. Tap the Connect
button, and tap the check mark.
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Set up a Data Site

1. Tap the Sites button. Select an existing site or tap the
New button to create a new site.

ﬂ@':erm Site
9:12:23 AM
12.26
Pres - PSI(FC)
23.07
Temp - C(FC)
28.27
Depth - ft{FC)
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2. Enterinformation on the subsequent screens and
continue by tapping the right arrow button. Tap the
check mark button when finished.

Set up a Data Log

1. Tap the View menu and select Logging.
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2. Tapthe More button, and then tap the New button.
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3. Add the log name and tap the right arrow button.

4. Selectthe parameters you want.

5. Rearrange parameter order if desired. Tap Edit to

change units.

Select alogging method appropriate for your
deployment.

7. Configure the logging method.

8. Select a start condition.

10.
11.
12.

13.

14.

When an instrument is deployed on a wire,
rather than a cable, you will not be able to
communicate with it after installation. Select a
Scheduled start if you are deploying the
instrument on a wire.

Select log wrap condition.
Select a level reference type.
Enter a specific gravity value for the deployment.

Configure the level reference. Your instrument MUST be
installed in its final location to set the level reference
correctly. If you are setting up a data log before installing
your instrument in its final location, you will need to select
either “Set First Logged Reading To” or “Remind Me to
Set Reference Later".

Select “Set First Logged Reading To” if you are
using a scheduled start, or “Remind Me to Set
Reference Later” if you are using a manual
startand are NOT deploying the instrument on
awire.

The software displays a summary. Look over your
selections carefully before clicking the check mark.

Start the log. A Scheduled Start log will start
automatically at its programmed time. To start a Manual
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1.

log, go to the Logging tab, highlight the log name, and
tap the Start button.

View or Download the Log

To download data, tap the Logging tab, and tap the
Download button. Select the desired download options
and tap the check mark when finished.

To view the data, tap the View button. Use the View
drop-down menu to select the data channel you want to
view. Select the date and time interval you want and tap
the check mark.
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Stop alLog

After you stop a log you cannot restart it.

. To permanently stop a log that has no scheduled stop,
go to the Logging tab, and select the log.

Tap the More button, and then tap the Stop button.

3. Make sure that you download the data after you stop a

log.

Drop the Connection and Exit Win-Situ Mobile
Software

Prior to physically disconnecting the RuggedReader from
the communication cable, tap the Connect button. The
button changes from blue to yellow and appears
disconnected.

To exit Win-Situ Mobile Software, tap the File menu and
select Exit.
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